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[bookmark: _GoBack]The STS form is used by general practices to update their organisation and health practitioners details for the delivery of discharge summaries and clinical information received from Queensland Health. Digital Health
Secure Transfer Form (STS) – Cheat Sheet

The STS form can be download and filled in online here 
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This cheat sheet will provide you with support on where to locate some of the information required on the form. 



Section 2 EDS/Clinical Letters 

Medicare Site Certificate ID (Medical Objects)
This is the General Practice’s site certificate registration number. The 10 digit code can be found: 
· On the registration letter and/or CD received from Medicare. 
· Online look webpage http://www.certificates-australia.com.au/general/cert_search_health.shtml
· Contact Medicare eBusiness Service Centre on 1800 700 199

CDA (Clinical Document Architecture) Ready 
This is a standardised electronic exchange format in which a discharge summary can be sent and received within clinical software. More complex information structures such as Pathology results can also be exchanged using this format.
Clinical software which is CDA ready includes: 
· Best Practice LAVA edition or higher
· Genie v8.8.6 or higher
· Medical Director v3.16b or higher
· ZedMed all version 

To receive a CDA discharge summary document at your practice, first check that your clinical software version meets the above requirement, then contact eHealth Queensland via email EDSTV-Corro@health.qld.gov.au to request your practice be setup. 

If your clinical software is not list above, please contact your software vendor to discuss their plans in supporting CDA format documents. 

HPI-O Number (Healthcare Provider Identifier – Organisation)
General practices HPI-O number can be located on the confirmation letter received from Medicare or from within your clinical software. 

Please see below for instructions to view your HPI-O within your clinical software:

Best Practice: 
From the Setup Menu choose Practice Details. Click on the Change button
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Medical Director: 
From the Tools menu choose Options. Click on the Practice tab 
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Zedmed
From the Practice Setup menu choose Practice
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Genie
From the File menu choose Practice Preference. Double click on the Clinic Name
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Health Practitioners Details

The health practitioners HPI-I (Healthcare Provider Identifier – Individual) and provider number can be find within your clinical software. 
If the health practitioners HPI-I has not already been entered into your clinical software, it can be obtain by contacting AHPRA on 1300 419 495 (the GP would need to do this), for additional information click here 
http://www.bsphn.org.au/wp-content/uploads/2014/06/HPI-I-numbers.pdf 



To view health practitioners details within your clinical software 

Best Practice
Click on the Setup menu and choose User. Double click on Health Practitioners name to display their details:
Health Identifier field is the HPI-I
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Medical Director 
Click on the Users menu and choose Setup Users. . Double click on Health Practitioners name to display their details:
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Zedmed 
Click on the Practice Setup menu and select Doctors. Select Finding Treating Doctor from the sub menu. Search for the health practitioner via the family name or Dr Code fields. 
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Genie
From the File menu select All User Preferences. Double click on the health practitioners name to display their details:
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Useful resources and information is available on the Brisbane South PHN Digital Health webpage 
http://www.bsphn.org.au/primary-health-support/digital-health/

For enquiries or support please contact the Digital Health Team
Phone: 1300 467 265 or Email: ehealth@bsphn.org.au
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Health Practitioner Detalls:

Please List ALL Practitioners in this section - Practitioners not listed will be removed from your Practice within the STS AddressBook.

Title First Middle Last

I Name Name Name Provider Number

—





image2.png
ABN Number.
VSP Nurmber

Healh denier

[ Evaluston only
Site 1D Numbes:

Licence Code:

‘B003621568630916

o

[BNMICHMAR HWC4MHJ DHNR





image3.png
hitps://onlinetraining digitalhealth.gov.au/ portal/desktop/index htrm £~ @C | @ public Consultations — Secon... _ VMuware Horizon fngAgcy ]

MedicalDire| ¥ [linical 3.17.1 - o EEN|

(< 6]
a

Open_File_Patient _User Tools Clinical Comespondence Search _Resources _Sidebar _Help

Options =

Newak | Lnks | Pompls | Cincal | Hisoy | Examinaton
Drug/Patient Support Devices PR RSD Recal
General | Prescibing | Progiess notes | Practce [ Lists Investigations.
Practkcenane  EHTA
Addess 400 Gearge Steet
Ciy/Subub  [Bisbane Postcode (4001 |
Prone 0730230000 ]
Phane (AH)
Emal
Packeld (52252
VSP number
HIONo  [soa3Enit i o8
Organisation Type | General Practice. v
Service Type General medical practitoner service: v
[ Use Subub and Postcode as defau for new paents
Government programs
PIP number

[ Participates i the CTG PBS Co-Payment measure

[¥] Autocapialise names Save Cancel

Dr Phillp Lang MD Live Data - LOCALHOST\HCNSQLO7  Friday, 6 Octaber 2017 2416





image4.png
https://onlinctraining.digitalhealth.gov.au/ portal/desktop/index htm

e oo coedar || LX)

@ Public Consultations — Secon

2
Management Reports  Toals

Reception

Patients (F4)

Practce etup WP Setup_ Usities
[ Management

Waiting Room

Appointrents

Daily Reports

Banking

Clinical Records

[2edmed SW Support
el 1300933000
Fax 0392843339

|Aer Hours: 0408 002 964

Help.

Reports

DEMONST{ ¥ JON SYSTEM -

Utilities

Practice Details

Practce | Branches | Departments | Bank Accounts

DMED TEN

Neme N

[ABN +] [21727171717 Medclaims MinorID [MPKODDDT  Exportto {0

~eHealth Information

HP+O 8003 6215 6669 0916 Search Hi Service

Orgarisaton [General Pracice =] Or9enisaon [Ganeraimedicalpro ]

ype — senvice
None ]

Integrated Eftpos/Eesyclaim provider
o= Notity unprocessed

after |_ days

Check Hl Provider
Classiications

Tyro Bulk bill

I Automatically Pro

W FamiyLiks [ Find erch'd/deceased [ Gobal File Numbers
¥ Roundto5 cents ¥ Show Do in Selectors ¥ Using Zedmed Clinical
Practice Definable Fields
Category Fields TextFields

Name

Possible Values

]

Patient Types

Hi Service Setings

Clgse GCancel

Radiology Setiings |

ZeDMED

FOCUSED INNOVATION

DEMONSTRATION SYSTEM

COREEN.

OnDemandTrainingUser

Build 2600331

LR e

3





image5.png
Pradtice Details piscellaneous.

Ginic Nae
address 1
address2
Suburbistate/Code
Country

Phane.

Phane 2

Fax

Enai

Webste

VP tamber
acto

Ao

Use ABNI o for
1o

s
Medcare Acct 1D

Practice Letterhead | Images & Attachments | Clnical | Carrier Identifiers

DHSITESTORGSTAL
it AN Ve

0 Stanford Road

GRINCELWALD | TAS [7277

Autr

o7 3720 2801

o7 3720 2802

info@geriesoltions.con.su

50330942711
Pracice ABN () Dactor’s ABN

003 6215 6663 0516

1 ovAAD 2

Edit Practice Preferences

iy server is hosted i a tine zone

Set 0 2270 unlessyour server s hosted 3 dferent tive zone.

[Z]No Default Siteof Service an Invaices
V] Allow Inveices to b Deleted

[ Print Medicare Claim Forms
For all accounts

Ol for unpaid accounts

[V]Print Overseas Student Claim For

IFfeld Fee Type'is equal o os
OSHC Provider Code os

GsTRate: [ 10%

Fancial vearstarting: 1 w01
Inactive

Pugedfron  00/00/0000  Last Purged

0 s shead

00/00/0000

Cancel

Save





image6.png
Waker

Piincipaldoctor v
(073333333

doctor@gp.com

Qualfcations
3

Provider No:

Presaiber No:

RegstaionNo.

Heath Idertfr

CPD No:

©Fulime OPatiine Otocum
[JVocationaly registered [ DVALMO

[JHas appointmerts

[ClHas sccoums AN Ko

7] Requies el o Mecicae bilng

Delauk scoount ype: |Diect B

Defaul ltem Nor

Usual locaton Main sugery

] Make notes coriidential





image7.png
https://onlinctraining.digitalhealth.gov.au/ portal/desktop/index htm

£ - & 0| @ Public Consultations — Secon.

ARHO

a MedicalDirector Clid_¥ J3.17.1 - [Setup users] -8
@ Fie Window Help =l
% UserDatmbase | =t o (Gmmtines] [
Theie s curtenty T prescrbes n the dtabase.
[inchide Inactive Users?
User Caegoy Addess Phone Tipe Qualfcaions Prescrber No. Praveer o,
D1 Phlp Lang Doctor 400 George Stueet BRISBANE 4001 0730230000 Fresciber  MD amm s
Edit Doctor Details
UserDetals MyteathRecord Detal
i D! PRk Larg B [¥] PatichateinMyHealhRecord
Addess: e When the Partcipate n MyHeaitecord option s checked
You can donroad o pload ciical documentsfo each paiens MyHealtlecard.
! Trisis subjec o each paten’s MyHealtecord secuy stalus.
s Bishste You can pload presciption ecords fo each patiens Mykealffecord
Postcode: o Registaion wih Frescrbing i requred andis aso subect to each palients
P consent.
Phone: 0730220000
Tie: o
Fax
Preseer o [ | bl H{EED ]
ProvderNo sz | e e ]
HPH No: ameR s | LestName:  [Lang ]
Stel Regitaton No:
Quaiicaions: Mo | G
Emat 1 Status | Notregiered
= required felds O Enable cFrescrting
Receive dspense natfcaton - sk Patent
Slue _ Receive dspense nolifcation -Dont Ask Patiert
el O Locum ® Disable ePrescibing
I Top Level Access? (¥ Options Edtng? (4] Dala Evpor Piviges?
|Autocaptals names [JPKI Encypton [V MyHeathFecord Assisted Regisation
oK Cancel
[ AddDoctar | | AddNurse Practiones | | Add User Ea Dekle Passward | [Make Inacive | [ Manage Allses | [ Close
O Philip Lang LOCALHOST\HCNSQLO?  Friday, 6 October 2017 21742 PM

SN





image8.png
o https:/onlinctreining digitaihealth.gov.au/portal/desktop/indec il £ - & ¢ @ Public Consutations — Secon e x| B 689VVN - MG - Calendar
2) DEMONST( ¥ JON SYSTEM
Management Reports Tools Practice Setup WP Setup _Utiites _Help
Reception Management Reports Utiities
Batching
Debtors
Reports Doctor Details
Identity Pracice
] ¥ HCRegistered
Practce Setup Family Neme [EEE1 OrCode [CG z S{?AOR,,Z,;“G i’
Rt T E— i
Given Names [Car Defeulttem # I Rl Regeiered
Title [or Search HiSenvice ~] Clear
WP Setup Fee type overide
£ EHealthiD (HPH) [8003 6193 00021749 DrType
ABN/Bus. Name [Branches
Branch [DEMONSTRATION SYSTEM =l
"Home Address
Benk List[Alber Road MC Bank Accourt -
-~ MA Format [ General Practiioner -
Provider# [205476TW  Other Provider#
Suburb —
— ErxEnity ID) Inyoice Header | _Anather
Employment
Phone Numbers rlom
Home Phone No Employment Record!
Home Fax
Mabile Phone Deteils | New
| Clinical Settings Stetus Extomel Primary
Qualifcation [MBBS F Available ™ Assistonly I~ 21o00 Fore
PrescriberNo [877656 ECLIPSE Fund Schemes | 7 Show Code on Appt Screen
Email Address
Find concel | e |

ZeDMED

FOCUSED INNOVATION

DEVONSTRATONSYSTEM | CoReen OnbemandTraningUier Buid 2600331

[zedmed Support
IPh:03 9264 3300 Fax 0392843399
E: support@zedmed com au

e zedmed com e

R | ed| @





image9.png
e@ 9 https//onlinetraining digtalheakth govau/portal/desktop) indec il £ - @ ][ @ publc Consutations —Secon..
s
Ble Edt Open Records Special Help
o} Patient: 0 of 15 Records - Current User Charley Fletcher ===
= & '
e +2ols R OEETF
Sumame | FirstName | Middle | DOB | T =
L%} Preferences: Charley Fletcher
Chasey Ftcher
NEHTA Adin
e [ My Health Record
FrstName Charey Actvate ortisUser
e
b 1 eck automaicaly when opening  Paties lrcal Record
Sumame Fetcher | reauired
i  — ZRetriove Medcere Overview when opening My Health Record Tab
P — [E I — [RIEEE—
Presabertomber [0
S oft Fodregads |
Payeeproviero || Thisfied el the HIC whos to recsive MedClains chegues
5. ths user s  locum, uk the prncpals Provider
Niber here,
T —
Provider Type GeneralPraciioner v | General Medical Pracitoner v
Defauk Bank Account ¥ []Check Referral vaidty in Appaintments
Vedel Registotiontuber |
osHCUser D ]
en1 wmesaesE | f
e e —





image10.jpeg
RISBANE SOUTH

phn

nt Initiative

An Australian Governmer




image11.png
l BRISBANE SOUTH

An Australian Government Initiative





image12.jpeg




